
  

 
 

AMD GPU PerfStudio Version 1.2 
 

Overview 
GPU PerfStudio is a real-time performance analysis tool which has been designed to help tune 
the graphics performance of your DirectX 9, DirectX 10, and OpenGL applications.  GPU 
PerfStudio displays real-time API, driver and hardware data which can be visualized using 
extremely flexible plotting and bar chart mechanisms.  The application being profiled may be 
executed locally or remotely over the network.  GPU PerfStudio allows the developer to override 
key rendering states in real-time for rapid bottleneck detection. An auto-analysis window can be 
used for identifying performance issues at various stages of the graphics pipeline. No special 
drivers or code modifications are needed to use GPU PerfStudio. 
 

 
GPU PerfStudio Application 
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Setup/Installation  

Before installing GPU PerfStudio, uninstall all previous versions of GPU PerfStudio and PerfDash 
and you must have administrator privileges. GPU PerfStudio works best when run remotely. You 
must run the GPU PerfStudio installer on both machines – the “client” machine running the GPU 
PerfStudio application and the “server” (target) machine running the application to be profiled. If 
you select a custom install, you can install only the server or client on an individual machine.  
 
GPU PerfStudio client requirements: 

�  Windows XP SP2 or Vista 
 
GPU PerfStudio server requirements: 

�  Windows XP SP2 or Vista (32 bit) 
�  Radeon 9500 or better (for hardware data) - CrossFire systems not supported 
�  CATALYST 7.12 or later (for hardware data) 

Running GPU PerfStudio 

In GPU PerfStudio you can connect in three modes, API (API Call Statistics, API State Override), 
HW (Hardware Counters, Driver Data) and ALL (API and HW simultaneously). You can switch to 
another mode while running GPU PerfStudio. You can connect to the local machine or any other 
machine you have access to. Before connecting to a machine, ensure that the GPU Performance 

Server is running by looking for the GPU PerfServer icon ( ) in either the system tray or taskbar 
on the server (target) machine. Currently, you cannot use GPU PerfStudio with multiple target 
applications or applications which use multiple rendering contexts. Also, multiple connections are 
not supported; one server and one client only can be connected. 
 
The Windows Firewall can be used to control which machines have access to the server 
machine. 
 
Often the status bar (at the bottom of the GPU PerfStudio client window) contains hints and tips 
for using GPU PerfStudio. 

Connecting  

To connect in any mode, you must drop your application (or shortcut) on the appropriate app 
launcher icon on the desktop of the server machine. On Vista, there are three app launchers; one 
for DirectX 9, one for DirectX 10, and one for OpenGL. On XP, there are two app launchers; one 
for DirectX 9 and one for OpenGL.  
 
Before connecting, you must first choose the type of application you wish to profile: DirectX or 
OpenGL.  This can be selected on the “Connection” menu by choosing either “DirectX Target 
Application” or “OpenGL Target Application” as shown below. 
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Connection Menu 

 
 

 
After setting the target application type, on the machine running GPU PerfStudio (client machine), 
type in the name (or IP address) of the machine you wish to connect to in the target machine 

combo box  (do not use “\\” before the name of the machine) and then click 
on the connect button (  ,  or ).  

 
 
Once GPU PerfStudio says you are connected, you should see data in the table view windows. 
You can click on the header of any column to sort the column or right-click on the numeric data 
for a real-time graph or bar chart. 
 
The Graphics State window can be used to override API states in real time. When you enable or 
disable a graphics state override, a marker line with a label will appear in all plot windows at the 
frame where the override occurred.  
 
In the Hardware Counter window, the “Default Counter Set” button can be used to restore the set 
of counters to all hardware counters supported on the current target machine. This can be useful 
if you want to keep the current window layout while connected to a different target machine or use 
a session file saved while connected to a different machine.  
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OpenGL Performance Note 

Please note that connecting in ALL or API mode in OpenGL may decrease the performance of 
your application.  However, the performance cost of connecting in API mode can be nullified by 
disabling “Real Time Update” in the “API Statistics” window as shown below. 
 

 
API Window 

 
By disabling “Real Time Update”, the cost of API mode is reduced while still providing you with 
the ability to perform state overrides. 

Disconnecting 

If you wish to disconnect from the target machine press the disconnect button (  ). Before 
connecting to a target machine, GPU PerfStudio will automatically disconnect before starting a 
new connection. 

Plotting  

To create a plot of any numeric data in GPU PerfStudio, simply right click on the numeric data 
and select the Plot submenu; you then have the choice of creating a new plot window or adding 
to an existing one. You can also drag any numeric data on to a plot window to add it to an 
existing plot. Many variables of different types can be plotted in a single window and you can 
modify the appearance of the graph or the individual data lines with the “Properties” context menu 
item on any plot window. The plotted data can be filtered. The “Reset” context menu item can be 
used to reset the auto scaled bounds of a plot. When you modify the API state (using the 
Graphics State window) a vertical marker line and explanatory text will appear on the plot 
indicating the frame where the state override occurred.  
 
The plot properties window can modify the appearance of a plot in many ways. The right and left 
axis data range can be set manually or fixed at the current values. Also, the format of the labels 
can be changed by clicking on the “Tick Label Format…” button. The color and width of the 
marker lines which are drawn at graphics state changes and the data lines can easily be 
modified. The amount of smoothing can be customized. Lastly, you can associate a data set with 
either the right or left axis. Clicking the “Revert Settings” button reverts all properties to the state 
they were in when the properties window was opened. “Frames to show” controls how many 
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frames of data are displayed in a plot window; GPU PerfStudio does not collect data for every 
frame of the target application. 
 
 

 
Plot Window 
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Plot Properties Window 

 

Bar Charts  

To create a bar chart of any numeric data in GPU PerfStudio, simply right click on the numeric 
data and select “New Bar Chart”. You can also drag any numeric data on the Bar Chart Window. 
In the bar chart window you can display several real-time bar charts at once. The properties and 
positions of the bar charts can be accessed by right clicking on a bar chart. The bar chart 
properties window can be used to modify the axis appearance and range of the bar chart and the 
appearance of the colored bar. It can also be used to indicate the alarm color and level. If you 
want to reset the maximum values of all the bar charts to reasonable values, right click on a bar 
chart and select “Reset Maximum of All Bar Charts.” 
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Bar Charts Window 

 

 
Bar Chart Properties Window 
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API Window 

The API Window displays all the DirectX 9, DirectX 10, or OpenGL calls made by the target 
application during the current frame. It is often useful to sort the third column of this window to 
see which calls are the most frequently used. If you have enabled API timing (in the Connection 
menu) the time (in nanoseconds) displayed is the time the driver takes in processing each API 
call.  If you do not need the timings of the API calls, do not check this option; it has negative 
performance implications. 

Radeon 9500 – X1950 Hardware Counter Descriptions 

Counter Name  Description  

% Hardware Utilization  Percent time GPU is busy 
% Vertex Wait for Pixel Percent time vertex processing is waiting for pixel processing to 

finish (can indicate slow pixel shaders) 
% Pixel Wait for Vertex Percent time pixel processing is waiting for vertex processing to 

finish 
Pre-clip Primitives Primitive count before clipping        
Post-clip Primitives Primitive count after clipping        
% Blended Pixels  Percent of total pixels drawn with blending enabled 
ALU to Texture Instruction 
Ratio  

Ratio between pixel shader ALU and texture instructions (not 
available on Radeon X1300 to X1950 or on OpenGL) 

% Pixels Passed Z-test Percent of pixels which passed the Z-test 
Overdraw  Total number of pixels drawn divided by the Overdraw counter 

resolution.* This counter can also be representative of the number 
of render targets in use. 

  
 
“% Hardware Utilization” indicates how much time during a frame is spent doing 3D rendering. A 
low value here probably means that other tasks (AI, or CPU-based collision detection, etc.) are 
taking up more time than 3D rendering; in this situation you could use more complex 3D effects at 
very little or no cost. 
 
“% Vertex Wait for Pixel” and “% Pixel Wait for Vertex” indicate how front end or back end bound 
the graphics pipeline currently is. For example, let’s say that % Vertex Wait for Pixel” is higher 
than “% Pixel Wait for Vertex;” this indicates that the application is currently fill bound as opposed 
to vertex bound; this could be an expensive pixel shader or blending operation. 
 
The primitive counts let you get an idea of how many primitives (triangles, lines, points) the 
hardware is actually drawing. . A common problem is a high pre-clip primitive count but low post-
clip primitive count. This implies that the engine is sending (and vertex processing) a lot of data 
that isn't then rendered. Look to improve gross culling (bounding boxes, BSP trees, PVS etc.) 
 
“% Blended Pixels” can show cases of excessive alpha blending. 
 
“% Pixels Passed Z-test” can have several meanings; a high value means that either 1) the 
application is very efficiently using Hierarchical Z (many pixels being eliminated by Hierarchical Z 
so very few pixels which fail the regular Z test), or 2) the application is rendering back to front.  
Since efficiently using Hierarchical Z will increase performance and rendering back to front will 
decrease performance, you can differentiate between the two cases is by forcing Z- Test off (in 
the Graphics State window) and then viewing the rendering order.  
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*The Overdraw counter resolution is set by the user in the Counter Options window accessible 
from the View menu. For example if you are rendering to a 1024x768 back buffer, enter 1024 and 
768 in the width and height fields. If you want to see the raw pixels rendered instead of Overdraw, 
simply put a 1 in both the height and width fields. 

Radeon HD 2400 – HD 2900 Hardware Counter Descripti ons 

Counter Name  Description  

% Hardware Utilization  Percent time GPU is busy 

% Vertex Wait for Pixel Percent time vertex processing is waiting for pixel processing to 
finish (can indicate slow pixel processing) 

Pre-clip Primitives Primitive count before clipping        

Post-clip Primitives Primitive count after clipping        

ALU to Texture Instruction 
Ratio  

Ratio between pixel shader ALU and texture instructions (only 
available in OpenGL) 

Overdraw  Total number of pixels drawn divided by the Overdraw counter 
resolution.* This counter can also be representative of the number 
of render targets in use. 

Texture Cache Miss Rate Texture cache miss rate in bytes per pixel 
PS ALU Instructions 
Executed 

Pixel shader arithmetic instructions executed (only available in 
OpenGL) 

PS TEX Instructions 
Executed 

Pixel shader texture instructions executed (only available in 
OpenGL) 

VS ALU Instructions 
Executed 

Vertex shader arithmetic instructions executed (only available in 
OpenGL) 

VS TEX Instructions 
Executed 

Vertex shader texture instructions executed (only available in 
OpenGL) 

Post HiZ Sample Count Number of samples after HyperZ 
Post TopZ Pixel Count Pixels after early Z culling has taken place 
Post Shader Pixel Count Pixels after shading and alpha test have taken place 
TopZ Reject Rate Rate of pixel rejection due to early Z test 

 
(For a description of the first five counters see the previous section.)  
 
In the HD 2000 architecture, “% Vertex Wait for Pixel” is indicative of non shader portions of the 
graphics pipeline such as clipping and depth testing. 
 
“Texture Cache Miss Rate” indicates how effectively you are using the texture cache; a typical 
per-pixel miss rate (when using trilinear and anisotropic filtering on mipmapped 2D textures, 
typical 3D usage) is 0.25 (compressed) to 1.0 (32 bit) bytes per pixel. In 1:1 pixel:texel mapped 
cases (e.g. postprocessing blits) the exact amount of memory processed will be shown (4.0 if the 
source is 32-bit, 8.0 if 64-bit, etc.). Check the texture cache miss rate is not outside the expected 
ranges - the most likely cause is non-mipmapped textures; all textures should be mipmapped for 
optimal performance. 
 
“Post HiZ Sample count” is the number of samples rasterized after large-scale Z culling. “Post 
TopZ Pixel count” is the number of pixels present at the exit from rasterization. “Post Shader Pixel 
Count” is the number of pixels after pixel shading and alpha test. 
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“TopZ reject rate” indicates how many pixels rejected by early Z testing. You should check that 
the majority of Z rejects are TopZ unless the current shader in use is very short (or it’s a Z-only 
rendering shader); later Z rejects incur the cost of shading even if the pixel is not visible.  

DirectX9 Driver Data Counter Descriptions 

Counter Name Description 
Framerate Frames per second 
LocalTextureMem Local texture memory used 
AGPTextureMem AGP texture memory used 
LocalVBIBMem Local Vertex buffers and index buffer memory used 
AGPVBIBMem AGP Vertex buffers and index buffers memory used 
TextureUpload Texture data uploaded 
VBIBUpload Vertex buffers and index buffers data uploaded 
PrimsPerRSChange Primitives rendered per render state change 
PrimsPerTSChange Primitives rendered per texture state change 
PrimsPerVSChange Primitives rendered per vertex shader change 
PrimsPerPSChange Primitives rendered per pixel shader change 
PrimsPerVSCChange Primitives rendered per vertex shade constant change 
PrimsPerPSCChange Primitives rendered per pixel shader constant change 
FlipStall Stalls on frame buffer flip 
VBStall Stalls on vertex buffer 

 
The memory counters can be used to determine if your application is using AGP memory which 
can negatively affect performance. 
 
The “Prims per RS/TS/VS/PS/VSC/PSC change” counters indicate how well you are batching 
your primitives. Larger batch sizes should contribute to higher performance. 
 
If the “Stalls on Flip” counter is non-zero it could mean that you are locking the frame buffer and 
reading from it, which is can drastically reduce performance. 
 
If the “Stalls on VB” counter is non-zero, you might be locking dynamic vertex buffers without the 
DISCARD/NOOVERWRITE flags; this will negatively affect performance. 

DirectX10 Driver Data Counter Descriptions 

Counter Name Description 
Framerate Frames per second 
FrameTime Frame time in nanoseconds 
GeometryBufferAllocatedDefault 
GeometryBufferAllocatedImmutable 
GeometryBufferAllocatedDynamic 
GeometryBufferAllocatedStaging 
GeometryBufferAllocated 

Allocated memory for vertex and index buffers 
and stream output 

GeometryBufferUsedPercentage 
Percentage of allocated geometry buffer 
memory used 

ConstantBufferAllocatedDefault 
ConstantBufferAllocatedImmutable 

Allocated memory for constant buffers 
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ConstantBufferAllocatedDynamic 
ConstantBufferAllocatedStaging 
ConstantBufferAllocated 

ConstantBufferUsedPercentage 
Percentage of allocated constant buffer 
memory used 

RenderTargetAllocatedDefault 
RenderTargetAllocatedImmutable 
RenderTargetAllocatedDynamic 
RenderTargetAllocatedStaging 
RenderTargetAllocated 

Allocated memory for render targets 

RenderTargetUsedPercentage 
Percentage of allocated render target memory 
used 

TextureDepthStencilShaderAllocatedDefault 
TextureDepthStencilShaderAllocatedImmutable 
TextureDepthStencilShaderAllocatedDynamic 
TextureDepthStencilShaderAllocatedStaging 
TextureDepthStencilShaderAllocated 

Allocated memory for ShaderResources, 
DepthStencil buffers and Textures 

TextureDepthStencilShaderUsedPercentage 
Percentage of allocated 
TextureDepthStencilShader memory used 

PrimsPerRenderStateChange Primitives rendered per render state change 

PrimsPerDepthStencilStateChange  
Primitives rendered per depth stencil state 
change 

PrimsPerBlendStateChange Primitives rendered per blend state change 
PrimsPerPixelShaderChange Primitives rendered per pixel shader change 
PrimsPerVertexShaderChange Primitives rendered per vertex shader change 

PrimsPerGeometryShaderChange 
Primitives rendered per geometry shader 
change 

PrimsPerPSSamplerStateChange 
Primitives rendered per pixel shader sampler 
state change 

PrimsPerVSSamplerStateChange 
Primitives rendered per vertex shader sampler 
state change 

PrimsPerGSSamplerStateChange 
Primitives rendered per geometry shader 
sampler state change 

 
The memory counters can be used to determine if your application is using non-local memory 
which can negatively affect performance. The total amount of memory for a certain type of 
resource is also displayed; for example, “ConstantBufferAllocated” is the sum of four pools of 
constant buffer memory. The “…UsedPercentage” counters indicate the total amount of memory 
used divided by the memory allocated.  
 
The “Prims per … change” counters indicate how well you are batching your primitives. Larger 
batch sizes should contribute to higher performance. 
 

OpenGL Driver Data Counter Descriptions 

Counter Name Description 
Framerate Frames per second 

VertexBufferObjectMem 
Amount of memory used to store vertex buffer objects 
(vertex and index buffers) 

TextureMem Total amount of memory allocated for textures 
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UncompressedTextureMem 
Amount of memory allocated for uncompressed 
textures 

CompressedTextureMem Amount of memory allocated for compressed textures 
 
The VertexBufferObjectMem counter tracks all VBOs allocated by the application for both vertex 
buffers and index buffers.  The total amount of memory allocated in VBOs is reported by this 
counter. 
 
The texture memory counters track all of the static texture images specified to OpenGL with 
glTexImage1D, glTexImage2D, glTexImage3D, glCompressedTexImage1D, 
glCompressedTexImage2D, and glCompressedTexImage3D.  The compressed and 
uncompressed counters refer to the amount of memory allocated for each texture type. 

State Overrides 

Override Description/Possible Bottleneck 

Force 2x2 Textures 
Is texture bandwidth (large textures) affecting performance? (not 
available in OpenGL) 

Force Disable Texture 
Filtering Are expensive texture filtering modes affecting performance? 

Force 1x1 Scissor Region 
Identifies vertex processing bottlenecks (by removing most pixel 
processing) 

Force Simple Pixel Shaders Identifies expensive pixel shaders 

Force Skip Draw Calls 
Identifies non-GPU bottlenecks (by removing most 3D graphics 
work) 

Force Z Test Enable Identifies z-order performance issues 
Force Z Write Enable Identifies z-order performance issues 
Force Alpha Blend Enable Identifies alpha-blending performance issues 

Force Alpha Test Enable 
Can identify problems related to early Z test (not available on 
DirectX 10) 

Force Cull Mode Can show culling efficiency 
Force Fill Mode Used for debugging and identifying vertex density 

 
There are two sets of overrides: RenderTarget and BackBuffer. These two sets are completely 
independent and are extremely useful for application which use render to texture effects or full 
screen effects like depth of field.  
 
For DirectX 10 applications, the alpha test state overrides are not available because alpha test is 
not part of the DirectX 10 specification. 
 
For OpenGL applications, the force skip draw calls override does not affect drawing which is done 
with display lists or immediate mode.  Only draw calls made with glDrawArrays, glDrawElements, 
glDrawRangeElements, glMultiDrawArrays, or glMultiDrawElements are skipped. 

Analyzer Window 

The Analyzer Window can be used to automatically identify bottlenecks in your application; it will 
run through a series of experiments turning on and off state overrides and measuring framerate. 
You must be connected in ALL mode for the Analyzer window to operate; you should also try to 
keep the scene being rendered as constant as possible (no camera motions or animations) for 
the most accurate results. The Analyzer window automatically compares the framerate with no 
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overrides to the framerate with several back buffer and render target overrides; if appropriate, the 
results are flagged with a colored background and informative messages are displayed.  

 
Analyzer Window 

Identifying Performance Bottlenecks 

All the data and the state overrides that GPU PerfStudio provides can be used to identify and 
eliminate performance bottlenecks. If you think you have a 3D rendering bottleneck, it’s best to 
prepare your application for performance analysis by running your application with vsync off, and 
shutting off all CPU related activities (AI, collision testing, animation, etc.); running the target 
application in full screen mode will yield the most accurate analysis. The Analyzer window can 
provide an initial indication of the location of any bottleneck. To begin a more detailed 
investigation, look at the “% Hardware Utilization” counter. If performance (frame rate) of your 
application is low and this value is also low, then your bottleneck is not related to 3D rendering; 
use a tool like VTune or CodeAnalyst to profile your application.  After non-graphics profiling, if 
you are still experiencing low frame rates, your “% Hardware Utilization” should be much higher; if 
it is not, there are additional non-graphics issues. 
 
The state overrides are a good place to start for finding a graphics bottleneck; while looking at the 
frame rate you can try forcing states on and off. Forcing 2x2 textures can show if large textures 
are affecting performance; similarly, forcing texture filtering off can indicate expensive texture 
filtering modes (like anisotropic filtering). If you force 1x1 scissor region, most pixel processing 
will not be done; this can show a performance problem with the number of vertices or long vertex 
shaders. Forcing simple pixel shaders can demonstrate a performance problem with expensive 
pixel shaders. If none of these state overrides improves performance, you can try skipping all 
draw calls; this should eliminate most of the work related to 3D rendering so your frame rate 
should go up significantly – if it does not then you probably have an undiscovered CPU related 
performance issue.  
 
Forcing Z Test and Z Write off can show if you are rending in front to back order (as you should 
be). Turn off alpha blending to determine if alpha blending is causing a performance problem. In 
certain situations, alpha testing can affect the early Z test; toggling it on and off may show if using 
alpha test is causing performance degradation. Switching into wireframe mode and turning off 
culling can be used as a debugging tool to gauge vertex density and find obscured objects.  
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Preferences 

The Preferences window (accessed from the View menu) can be used to change the number of 
connection attempts. It can also force GPU PerfStudio not to connect when a session is loaded; 
this is useful if you want to connect to a different machine than the one stored in the session file. 
Preferences can also be used to change the update frequency (the number of times per second 
that GPU PerfStudio gets and displays data). Clicking the “Revert Settings” button reverts all 
preferences to the state they were in when the Preferences window was opened. 
 

 
Preferences Window 

Target Application 

In the Connection menu you can set the target application which will run on the target machine. 
The path is local on the target machine. You can control when GPU PerfStudio tries to start the 
application: never, when it tries to connect while loading a session or at every connection attempt. 
To prevent multiple instances of the application from running, the user must manually stop the 
running application before GPU PerfStudio attempts to start it. 
 
Note: It is not necessary to set the target application; instead, you can manually run your target 
application. Setting the target application in GPU PerfStudio is provided as a convenience 
feature. 
 
 

 
Target Application Window 

 
 
Since remotely running applications can present a security risk, the GPU PerfServer provides a 
per-application level of security. To open the GPU PerfServer window, double click on the tray 

icon ( ). GPU PerfServer maintains lists of all applications which are allowed or denied remote 
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execution on the server machine. When GPU PerfStudio tries to run an application not on the 
allowed (or denied) list, GPU PerfServer pops up a dialog asking if is ok to run the application and 
add it to the list of allowed applications; the dialog also gives options to add it to the list of denied 
applications. You can also manually add and delete applications from the lists. To completely 
disable application validation, uncheck the “Enable Application Validation” check box. If you do 
not want the GPU PerfServer to start when Windows starts, uncheck the “Autostart Server” check 
box. 
 

 
GPU PerfServer Window 

 

 

Saving and Loading  

Saving and loading a session works as expected. The position of all data and graphical sub-
windows, the current connection state and the target application are all saved in and restored 
from session files. 

Toolbar  

The state of the buttons on the toolbars represents the visibility state of the data windows. If you 
want to stop GPU PerfStudio from getting and displaying any data from the GPU PerfServer, you 
can uncheck the “Continuous Update” checkbox on the toolbar. The target machine combo box 
stores the last five machines to which GPU PerfStudio attempted to connect. 
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Tools  

The menu items in the “Tools” menu allow you to clear all the data from all tables and also reset 
all the plots; there is also an option for deleting all the plot windows. These options can be useful 
after a state override or a reconnection. 
 

Command Line  

There is currently only one command line option. If a session file is given on the command line, 
that session file will be opened when GPU PerfStudio starts. This can be useful if you use the 
same window layout or target application consistently. 
 

Troubleshooting GPU PerfStudio  

Sometimes GPU PerfServer can get wedged. If you are having problems connecting, close GPU 

PerfStudio, and close GPU PerfServer by right clicking on the tray icon ( ) and selecting Exit. 
Next, restart GPU PerfStudio and then restart GPU PerfServer using the desktop shortcut or Start 
menu: 
Start->All Programs->AMD->GPU PerfStudio 1.1->Restart Performance Server. 
 

Contact Us 

Please send any feedback, questions or suggestions to gputools.support@amd.com. 
 
GPU PerfStudio 1.2 utilizes the work of the Qwt project ( http://qwt.sourceforge.net ). 
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GPU PerfStudio Screenshot (Vista)  

 


